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Preoperative Introduction: Preoperative planning constitutes a fundamental tool in the management of frac-
planning; tures; however, its practical application is far from the desired, perhaps due to the absence of a
Digital templating; basic and simple method, adapted to the current times. We describe a digital planning method,
Computer software; halfway the traditional and the technological, which preserves its educational essence, allows
Fracture; for the understanding of the fracture and the individualisation of the osteosynthesis.
Reduction and Material and methods: After the initial analysis of the fracture and the patient’s characteris-
osteosynthesis; tics, different measurements are made on X-ray and CT images with a digital medical imaging
Training software. These images are then copied into a presentation programme (Microsoft® PowerPoint

or Keynote ©Apple Inc.), in which the main fragments and fracture lines are traced with the
computer pointer. These are subsequently moved into a reduced position and the implants for
internal fixation are graphically represented together with a guide of the surgical strategy.
Results: We show 4 cases of different types of fractures operated through reduction and
osteosynthesis after preoperative planning according to the described method. The basic points
for the surgical planning, logistics, tactics and postoperative radiological results of each case
are detailed.

Conclusions: Despite the rise of advanced planning software, traditional paper and pencil meth-
ods are still fundamental, even more so for the trauma surgeon in training. The digital planning
method described is very appropriate for this purpose, as it combines the advantages of both
methods: simplicity, accessibility, quickness, low cost, reproducibility, educational character,
efficiency and possibility of simulation, corrections and reuse of cases.
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PALABRAS CLAVE
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Planificacion digital;
Programa
informatico;
Fracturas;
Reduccion y
osteosintesis;
Formacion
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Planificar fracturas es sencillo: desarrollo de un método basico de planificacion
digital basado en la técnica tradicional con lapiz y papel

Resumen

Introduccién: La planificacion preoperatoria constituye una herramienta fundamental en el
manejo de fracturas; sin embargo, su aplicacion practica dista de lo deseado, quiza debido a
la ausencia de un método basico y sencillo, adaptado a los tiempos actuales. Describimos un
método de planificacion digital, entre lo tradicional y lo tecnoldgico, que conserva su esencia
educativa, permite comprender la fractura e individualizar la osteosintesis.

Material y métodos: Tras el analisis inicial de la fractura y caracteristicas del paciente, se
realizan diferentes mediciones en las imagenes de Rx y TC con un software de imagen médica
digital. Estas imagenes se copian en un programa de presentacion (Microsoft® PowerPoint o
Keynote ©Apple Inc.), en el que se reproducen con el puntero del ordenador los principales
fragmentos y lineas de fractura. A continuacion, estos se mueven a una posicion reducida y
se representan graficamente los implantes para la fijacion interna junto con un guion de la
estrategia quirlrgica.

Resultados: Mostramos 4 casos de diferentes tipos de fracturas intervenidas mediante reduc-
cion y osteosintesis tras una planificacion preoperatoria segun el método descrito. Se detallan
los puntos basicos para la planificacion quirirgica, logistica, tactica y resultados radiologicos
postoperatorios de cada caso.

Conclusiones: A pesar del auge de programas informaticos avanzados de planificacion, los
métodos tradicionales con lapiz y papel siguen siendo fundamentales, mas aln para el trau-
matologo en formacion. El método de planificacion digital descrito resulta muy adecuado para
este objetivo al aunar las ventajas de ambos métodos: sencillez, accesibilidad, rapidez, bajo
coste, reproducibilidad, caracter formativo, eficaz y posibilitar la simulacion, correcciones y
reutilizacion de casos.

© 2022 Publicado por Elsevier Espana, S.L.U. en nombre de SECOT. Este es un articulo Open

Access bajo la licencia CC BY-NC-ND (http://creativecommons.org/licenses/by-nc-nd/4.0/).

Introduction

The phrase planning is the key to success has been repeated
throughout history with nuances and variants and can be
applied to many situations. In Orthopedic Surgery and Trau-
matology (ORT), emphasis is placed on planning through the
use of a proverb with a similar background: Failing to plan
is planning to fail, of anonymous origin, being a fact that
no surgeon enters the operating room planning to fail, how-
ever, it is common to fail to plan." Thorough preparation
prior to surgery is fundamental to achieve the best results
for patients and must not be neglected.

Preoperative fracture planning provides numerous ben-
efits for surgeons and patients. Effective planning reduces
the risks associated with inadequate fracture assessment by
forcing the surgeon to study fracture tracings in detail, iden-
tify anatomical and technical details of the procedure, and
define the best way to reduce and fix the fracture based on
fracture pattern.” It also improves surgical efficiency and
outcomes’ by allowing surgery to proceed more smoothly,
avoiding unnecessarily prolonging surgical time and minimis-
ing complications.

For specialists in training, it is a tool to enable mana-
gement of the fracture prior to the surgical procedure and
it provides essential time to understand the fracture pat-
tern and its complexity, and to study the most appropriate
approach, reduction technique, and method of osteosyn-
thesis. This will help them approach surgery with greater
confidence, guaranteed success, and less stress.” Despite

its importance and the fact that it is one of the elementary
subjects and one of those most emphasized in introductory
osteosynthesis training courses, its practical application in
the day-to-day treatment of fractures is far from what is
desired?® although it is widely used in orthopaedic surgery to
correct deformities or in prosthetic surgery.*

Traditionally tracing paper, onion paper, or simple mea-
surements on plain radiographic (X-ray), or computed
tomography (CT) images have been used for preopera-
tive planning in the treatment of fractures."? These are
simple, familiar, low cost, low radiation exposure and edu-
cational methods. With the advances in digital medicine,
semi-automated planning software and 3-dimensional (3D)
printing technology have emerged as promising tools for
preoperative fracture planning,>~'" although their use is not
as widespread as might be imagined. The disadvantages of
new technologies, despite providing precision and simulat-
ing fracture reduction and placement of internal fixation
implants, are that they are less accessible, more expensive,
time-consuming, and complex.

The aim of this paper is to explain in detail a method
of surgical planning of fractures that takes an interme-
diate approach between the traditional and technological
methods, which is simple, reproducible, low cost, acces-
sible, relatively fast, and effective. These characteristics
and because the method follows the traditional principles
of fracture planning, makes it possible to understand the
complexity of a fracture and design an individualised ther-
apeutic plan that optimises outcomes for the patient. It is,
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therefore, very suitable, and instructive for ORT specialists
in training, although its use could clearly be extended to
more experienced surgeons.

Material and methods

We present a simple method of preoperative planning that
uses widely used commercial presentation software based
on X-ray imaging and CT support.

Preoperative assessment and surgical strategy

First the fracture and patient characteristics are analysed,
logistical details such as theatre layout, type of table,
patient positioning on the operating table are noted, and
the surgical strategy of approach, reduction, fixation, and
implants is decided (Table 1).

Then, based on the X-ray and multiplanar CT images
obtained from the Picture Archiving and Communication Sys-
tem (PACS), different measurements are taken in 2 orthogo-
nal projections with a digital medical image viewer (e.g.,
XERO Universal Viewer, Agfa HealthCare, Agfa-Gevaert
Group, Mortsel, Belgium). The measurements serve as a
reference to calibrate subsequent additional measurements
and vary according to fracture site, pattern, and method
of synthesis (width of tibial plateau or plafond, anteropos-
terior diameter of the distal femur or tibia, distance from
the articular surface to the fracture, width of the medullary
canal, etc.). When measurements are made from CT images,
the accuracy of these measurements is highly reliable,
whereas, for X-ray images, ideally a preoperative marker
should be used to calibrate the image or to estimate a mag-
nification of 15-20%.'>"'* The X-ray images are exported
in jpg/jpeg file format (Joint Photographic Experts Group)
and then copied into a presentation programme, Microsoft®
PowerPoint 2020 (version 16.44-20121301; Microsoft Office
package developed by Microsoft Corporation, Redmond, WA,

Table 1

USA) or Keynote (version 10.3.5-7029.5.5; iWork productiv-
ity suite for Mac, 2003-2020 Apple Inc., Cupertino, CA, USA).

Fracture segmentation

The digital X-ray images are inserted into a new blank slide
of any of the above-mentioned presentation programmes
and fracture segmentation is performed manually. To do
this, select from the toolbar: Insert > Shape > Freeform in
PowerPoint or Shape > Draw with the pen tool in Keynote
(Fig. 1A, B), and trace the borders of the main fracture
fragments and fracture lines freehand with the computer
pointer. We recommend choosing a border colour for the
fragments (e.g., blue) and another (e.g., red) to highlight
the fracture lines (Fig. 1C), which can be distinguished
from the black and white of the X-ray images: Shape
Format > Shape Outline > Colour in PowerPoint or For-
mat > Style > Border > Line > Colour in the right sidebar in
Keynote. In complex fractures, multiplanar CT images with
three-dimensional reconstructions provide more preopera-
tive information and better fracture characterisation.

Reduction simulation

The fragments are then filled with colour (e.g., red) and an
opacity of 40% is set to allow transparent visualisation of the
bone on the X-ray using the options: Shape Format > Shape
Fill > More Fill Colours > Opacity in PowerPoint or Format >
Style > Fill Colour > Opacity in the right sidebar in Keynote
(Fig. 1.D). The fracture fragments are moved by left click-
ing on them and dragging or rotating them into a reduced
anatomical position. To do this, the principles of reduction
must be applied depending on the type of fracture. Thus, in
articular fractures we will avoid steps on the articular sur-
face and in diaphyseal fractures we will try to restore the
appropriate length and a good coronal and sagittal align-
ment. In very comminuted fractures where the anatomy is
completely unstructured or in diaphyseal fractures, it might

Preoperative assessment and development of surgical strategy.

Patient age, sex, and history
Fracture classification and soft tissue status

Operating theatre layout: fluoroscope, surgical team and nursing table, type of operating table (orthopaedic, radiolucent,

traction)
Positioning of patient, supports and pads, ischaemia cuff.

Surgical approach, indicating main precautions, use of percutaneous or minimally invasive techniques

Method of reduction: direct, indirect, or combined

Instruments for reduction: reduction forceps, Kirschner wires, Schanz, long bone distractors

Internal fixation method: absolute or relative stability

Implants

DCP, LCP, interfragmentary screw and neutralisation plate, bridging plate, intramedullary nail, external fixator, use of

poller screws

Type of screws for implant fixation: compression or locking, cortical or cancellous, unicortical or bicortical
Length and thickness of implants and length, diameter and number of screws based on preoperative measurements and

theoretical principles of osteosynthesis

Need for drain. Closure. Method of immobilisation

DCP: Dynamic Compression Plate; LCP: Locking Compression Plate.
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(C) Tracing the edges of the main fragments (blue) and fracture lines (red). (D) Simulation of reduction of the fracture fragments
that are filled with red by setting an opacity of 40%.
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Figure 2

(A) Drawing of implant silhouette on surgical technique image obtained (medial distal tibial LCP plate, DePuy Synthes®,

Johnson & Johnson) and cortical and locking screws with the pen tool in Apple Keynote. (B) Diagram of surgical steps and graphic
representation of the reduced fracture and overlapping of the implants fixed with screws, noting the types, sizes, and lengths
according to preoperative measurements. KW: K-wires; LCP: locking compression plate; MIPO: minimal invasive plate osteosynthesis.

be useful to use the intact contralateral limb to trace its
contours and guide the reduction.

Implant selection

The principles of osteosynthesis and the surgeon’s own expe-
rience, the approach, the method of reduction and internal
fixation and the appropriate implants are selected based
on initial analysis of the fracture. Once the implant has
been selected, using the surgical technique manual provided
by the company, the image of the implant is copied onto

another blank slide to then draw its silhouette and details
with the abovementioned freehand or pen drawing tools
(Fig. 2A). The screws that will be used to fix the implant
to the bone are also drawn using this technique, the length
of the implant, the number of screws required, and their
size are calculated from the preoperative measurements.
Since the planning page in the presentation programme is
not real size, to adapt the size of the implants drawn to the
scale of the image, a mathematical rule of 3 is made with the
previous measurements, and the real measurements of the
implants are noted in the drawing and planning scheme. For
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Table 2 Example of the written script of surgical tactics and logistics.

Patient identification A.J.P 876452

Sex and age 57-Year-old male
History
Mechanism of injury

Fracture type

Fall from own height

Obesity, smoker, type 2 diabetes mellitus

Multifragmentary extra-articular distal tibia fracture and comminuted

suprasyndesmotic fibula fracture (AO 43A3.3)

Side Left
Procedure
Position
under left leg
Approach

Tibial MIPO and fibular MIPO
Supine position on radiolucent table, fluoroscope on right, ischaemia cuff on thigh, pad

Minimally invasive approach to medial distal tibia over malleolus and proximal

percutaneous approach over medial tibial diaphysis
Minimally invasive approach to distal and proximal fibula

Reduction
Implants

Indirect by traction/angulation, with reduction instruments, on a plate. ..
10-Hole medial distal tibial LCP 3.5 mm (187 mm)

10-Hole 3.5 mm LCP one-third fibular tubular plate (128 mm),

Screws

3.5mm distal and proximal locking screws for tibia

3.5mm cortical and cancellous screws for fibula

Closure and immobilisation

No drain. Resorbable suture and staples. Compression bandage

LCP: Locking Compression Plate; MIPO: Minimal Invasive Plate Osteosynthesis.

example, in case 1, the distance from the articular surface
to the end of the fracture is 98 mm on the sagittal slice
of the CT scan, and for the synthesis a plate of 133 mm is
chosen (to be able to place 3 locking screws distal to the
fracture trace), therefore, to calculate the length of the
drawn plate the same distance is measured again on the
planning sheet (from the articular surface to the end of the
fracture), which gives a length of 18.3 cm and the size of the
plate is calculated in the planning: if the real size of 98 mm
is 18.3cm on the drawing; 133 mm of the real-size plate is
24.8 cm on the drawn plate.

Simulation of internal fixation

After this, the graphic drawings of the selected implants are
superimposed on the X-rays with the reduced fracture rep-
resentation as a template, simulating the optimal site where
they should be placed, and the screws with which they will
be fixed are positioned. It is useful to use colours to differ-
entiate each implant and to know the order of placement
of each implant for optimal osteosynthesis, together with
an orderly written outline of the tactics and logistics of the
procedure (Table 2). It is also helpful to include text boxes
on the drawing to specify the characteristics and size of each
implant.

Surgical technique

The preoperative planning with the written script and tech-
nical drawing is printed out and placed in a visible location
in the operating room to be used as a guide and consulted
by any member of the team. It can also be converted into
a portable document format (pdf) to share with the rest
of the surgical team prior to the intervention: File> Save
as > PDF in PowerPoint or File > Export to> PDF in Keynote.
The approach, reduction and internal fixation of the frac-

ture are performed according to the planning, verifying the
measurements of the selected implants and screws intra-
operatively by direct vision, hand-held surgical metre, and
fluoroscopic guidance. It is important to bear in mind that
the planning should serve as a guide, but may differ in some
respects from the final procedure due to intraoperative find-
ings.

Table 3 shows a summary of the detailed steps for digital
planning following the method described.

Results

We show 4 cases as examples of different types of fractures
undergoing reduction and osteosynthesis after preoperative
planning according to the method described. The sizes and
lengths of the implants and screws were determined from
measurements on X-ray or CT images and the principles of
osteosynthesis.

Case 1. Representative case of planning in tibial
plateau fracture

A 34-year-old woman presented with a lateral tibial plateau
fracture with subsidence and comminution following a ski-
ing accident. The fracture was classified as an AO type
41B2" and Schatzker type IIl,"® and was scheduled for open
reduction with articular surface lift, fill with cancellous
bone allograft and internal fixation with cannulated sub-
chondral compression screws and lateral proximal tibial
locking compression plate to restore the articular surface
and achieve absolute stability (Fig. 3). The lateromedial
diameter of the tibial plateau and diaphysis were mea-
sured to select the screw size. In addition, the length
of the plate was calculated so that 3 locking screws
could be placed distal to the fracture trace. As the frac-
ture trace extended distally, a long plate was chosen
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Table 3

Summary of steps for digital planning following the method described.

1. View the X-ray or CT images with a digital medical image
viewer obtained from the PACS and analyse the fracture

2. Perform the necessary measurements for fracture planning
(variable according to pattern and site) and subsequent
calibration

3. Export the X-ray images in jpg format and copy to a blank slide
of a presentation programme (PowerPoint or Keynote)

4. Segment the fracture: manually trace the edges of the main
fragments (blue) and fracture lines (red) with the computer
pointer with the freeform or pen tool

5. Simulate the reduction: colour the fragments (red with 40%
opacity) and move them until they are in a reduced position

6. Select the implant: copy the image of the selected implant and
screws onto a new slide and draw their silhouette and details
with the freeform or pen tool. Adjust the size of the implants
to the scale of the image by using the mathematical rule of 3
with the previous measurements

7. Simulate internal fixation: superimpose the graphic drawings
on the reduced fracture as a template in the optimal place
where they should be placed, and their fixation with screws.
Use colours to differentiate them

8. Write an outline of surgical tactics and logistics: specific steps
to achieve reduction and osteosynthesis

(-

—+Tibial MIPO with distal medial
tibia LCP and fibular MIPO with 1/3
tubular plate

CT: Computerised Tomography; PACS: Picture Archiving and Communic.

and, due to the higher workload of this plate, it was
planned to place more screws distally for greater stabil-
ity.

Case 2. Representative case of planning in
pertrochanteric fracture

An 87-year-old male, independent for basic activities
of daily living and active, presented a pertrochanteric

T3

ation System; X-ray: plain X-ray.

fracture AO type 31A1.3." This was a fracture with a sim-
ple pertrochanteric trace, with the lateral cortex intact
and a third fragment involving the lesser trochanter in
which an indirect reduction on a traction table and percuta-
neous reamed cephalomedullary nailing was considered as
a method of relative stabilisation and fixation with a distal
locking screw in a dynamic position (Fig. 4). Both the choice
of the cervico-diaphyseal angle of the nail and the length
of the cephalic screw can be determined by using the value
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|§| PREOPERATIVE DATA:
*34-year old woman.
«Skiing accident.

Tibial plateau fracture
\AO 41 B2; Schatzker type Il

> Lateral tibial plateau
fracture with 20 mm
collapse and
comminution.

«Type of fracture: complex
articular

*Bone quality: good
*Reduction: direct
« Stability: absolute

—ORIF with prox lateral
tibia plate + bone allograft

* Supine position with 30° knee flexion.
Ischaemia. Fluoroscope.

+
and submeniscal exposure of joint
surface.

« Anterolateral cortical opening to elevate
joint fragments with impactor/scope.

« Temporary fixation with several KW and
introduction of cancellous bone allograft.

+ 2 23.5mm x 70mm subchondral
lateromedial compression screws.

* 8-hole (133 mm) lateral proximal tibia
3.5 mm LCP plate.

* 5-6 proximal locking screws (23.5mm
x 50-70mm)

* 4-5 mono or bicortical distal locking
screws (@3.5 mm x 26-30 mm).

Figure 3

Preoperative planning of lateral tibial plateau fracture. (A) X-ray and CT images with measurements. (B) Patient char-

acteristics, analysis and segmentation of the fracture and surgical strategy. (C) Surgical tactic list and graphic representation of
the planning of open reduction, bone grafting and internal fixation with compression screws and lateral proximal tibial LCP. (D)
Postoperative radiological findings. KW: Kirschner wires; LCP: locking compression plate; ORIF: Open reduction and internal fixation.

of the healthy hip previously measured on the digital medi-
cal image viewer on the anteroposterior pelvic radiograph.
Alternatively, an angle protractor template can be created
following the same technique as described above. In addi-
tion, the diameter of the medullary canal at the narrowest
area will be measured to calculate the diameter of the nail
and the width of the femur to calculate the length of the
locking screw. A short nail could be chosen since this was a
fracture without mechanical criteria for instability.

Case 3. Representative case of planning in
diaphyseal tibial fracture

A 57-year-old female, after a fall while practicing sport sus-
tained a diaphyseal fracture of the distal third of the left
tibia AO type 42B2c," with a multifragmentary suprasyn-
desmotic fracture of the fibula. The treatment strategy was
to perform an indirect reduction of the tibia and internal
fixation using an anterograde endomedullary suprapatellar
tibial nail (optional), reamed and locked with 3 distal screws
to achieve greater stability as the fracture was very dis-
tal, and 2 proximal screws, one in a dynamic position to
allow dynamization during follow-up if consolidation prob-
lems occurred. In these cases, to estimate the appropriate
length and diameter of the nail, it is useful to use an X-ray
of the contralateral limb, in which the length of the bone
and the diameter of the medullary canal at its narrowest
area are measured. Likewise, the anteroposterior and medi-
olateral diameters are calculated distally and proximally in
the different directions allowed by the nail to calculate the
screw lengths.

On analysis of the fracture, we saw how, being very dis-
tal and occurring in the metaphyseal transition zone, there
was the possibility of the distal fragment deviating in varus
during nailing, and therefore we were able to anticipate and
plan where to place a poller screw which, in this case, was
in the medial distal metaphyseal zone. Given that the fibula
fracture affected the distal 7cm and was comminuted, after
restoring the length and alignment of the tibia, an open
reduction and internal fixation of the fibula with a one-third
neutralization tubular plate was planned to achieve absolute
stability, since it affected the ankle joint (Fig. 5), although
fixation of the fibula with a plate in this type of fracture
is controversial. In this specific case, although an absolute
stability technique was considered in the planning, intraop-
eratively the fracture was very comminuted, and therefore
we decided to use plate fixation as a bridge, and relative
stability was adopted. Although nailing a fracture appears
to be a simple technical procedure, the surgical technique
involves many stages, and the planning should not ignore any
of them in order to make it an easy procedure to perform.

Case 4. Representative case of planning in
periprosthetic fracture

A 72-year-old female had an accidental fall on a public
road, sustaining a periprosthetic fracture of the distal femur
around a total knee arthroplasty implanted 11 years ear-
lier. This was a supracondylar femur fracture in which the
femoral component of the prosthesis was stable, and was
classified as a Lewis and Rorabeck'” type II1 and type V.3-B1
of the Unified Classification System (UCS) classification.'®
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PREOPERATIVE DATA:

*89-year-old male. HTN, DLP,
asthma, phakectomy...

*Casual fall at home.

Pertrochanteric femoral
fracture AO 31A1.3

» Simple pertrochanteric
fracture with intact lateral
cortex and third fragment
involving the lesser trochanter.

«Type of fracture: 3rd fragment
*Bone quality: poor
*Reduction: indirect

« Stability: relative

Figure 4

+ Supine position on traction table. Fluoroscope from
+ Closed reduction by adduction traction and IR/

+ Minimally invasive approach over trochanter.

« Entry point localization and intruductit_)n of initiator

. Prog_ressive drilling up to 13 mm distal and 15.56 mm
+ Trochanteric cephalomedullary nail (125°,

+ Insert nail to desired height (center-center or lower

+ Dynamic set screw.
* Distal locking screw (@5 x 30 mm), dynamic.

—CR and percutaneous anterograde
cephalomedaullary nailing.

caudal.

ER and under fluoroscopic guidance.
tool, then guide wire placement, passing
trochanteric fragment and diaphysis.
proximal.

215.5/11 x 180 mm).

third). Place guide wire, drill hole for cephalic screw
and measure length.

Preoperative planning of a pertrochanteric femoral fracture. (A) X-ray images with measurements. (B) Patient charac-

teristics, analysis and segmentation of the fracture and surgical strategy. (C) List of surgical steps and graphic representation of
planning of closed reduction and percutaneous anterograde cephalomedullary nailing with dynamic distal locking screw. Alternative
for measurement of the left cervico-diaphyseal angle using an angle protractor template. (D) Postoperative radiological findings.
CR: closed reduction; DL: dyslipidaemia; ER: external rotation; HT: hypertension; IR: internal rotation.

Since it was a simple diaphyseal fracture, an indirect
reduction with a relative stabilisation system, such as a
compression bridge plate with locking screws, was consid-
ered (Fig. 6). The aim was to restore the length, axis, and
rotation of the limb, without requiring a perfect anatomi-
cal reduction. The plate would function as an internal fixator
without intimate contact with the bone, thus also preserving
periosteal circulation. Minimally invasive systems allow the
plate and screws to be introduced through minimally inva-
sive approaches and screws to be placed percutaneously.
The size of the plate was calculated from the lateral femoral
epicondyle and proximally to a distance beyond 2-3 times
the fracture length. In case of intramedullary implants or
hip arthroplasty stems, the length should be planned with
the aim of achieving a minimum overlapping of 30 mm, to
splint the entire bone and reduce the area of interimplant
mechanical stress. Screw size was calculated by measuring
the lateromedial diameter of the femur at the distal and
diaphyseal levels.

The cases described here represent a limited number of
examples; however, this planning method can be applied
to almost any type of fracture and in almost any site,
provided we have the appropriate imaging tests for charac-
terisation and calibration. Therefore, in our centre we have
applied this digital planning method to fractures of the prox-
imal, diaphyseal and distal humerus, forearm, wrist, pelvis,
acetabulum, proximal, diaphyseal and distal femur, proxi-
mal, diaphyseal and distal tibia, ankle, and calcaneus, in

primary, periprosthetic and peri-implant fractures, and in
simple as well as complex fracture patterns.

Discussion

There are many references in the scientific literature on
the importance of good preoperative planning in the sur-
gical treatment of fractures and its benefits have been
widely demonstrated. There are now many, varied methods
of preoperative planning that are in continuous develop-
ment. Despite this, there are hardly any texts and scientific
publications that explain the planning process in detail, step
by step so that it can be applied in practical day-to-day
cases.

With advances in osteosynthesis knowledge, transmitted
over decades in many training courses, and even in books
such as Basic Principles in Fracture Treatment,? preoperative
planning has become valued as a tool in fracture manage-
ment. These sources constitute some of the most important
resources for learning about basic fracture planning fol-
lowing the traditional method, which involves drawing the
fracture fragments on tracing or onion paper from the X-
ray images and then fitting them together like a puzzle
to simulate their reduction. Transparencies of the implants
are superimposed as templates, which are traced over
the fracture drawing. This method has been applied by
other authors, who have highlighted its benefits in help-
ing communication between surgical team, specifying the
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—CR and suprapatellar IM
tibial nailing and fibular ORIF

+ Supine position. Pad under ipsilateral buttock and knee flexed 30°
on a roller. Fluoroscope from the right.
* SUPRAPATELLAR TIBIA NAILING:

+ Knee suprapatellar approach. Insertion of protective cannula.

+ Insert KW at tibial entry point (medial to lateral tibial spine and
anterior joint border).

+ Drill proximal hole 4-6 cm deep and insert guide wire into
medullary canal. Perform indirect reduction maneuvers, and
bypass fracture with the guide wire up to the distal fragment.

+ Progressive reaming up to 10.5 mm.

« Anterograde tibial nail 10° x 300 x 9 mm.

« Assess the need for ant/post poller type screw (25 x 28 mm).

« 3 distal locking screws (5 x 24-32 mm).

+ 2 proximal locking screws (@5 mm; one dynamic).

* FiBULAR ORIF:

* Direct lateral approach of fibula.

« Direct fracture reduction with reduction forceps.

- Placement of 9-hole (110 mm) 3.5 mm 1/3 tubular plate.

+ 3 Proximal cortical screws (23.5 mm).

- 2-3 Distal cancellous screws (3.5 mm).

|§| PREOPERATIVE DATA:
*57-year-old female.
«Fall while practicing sports.

Diaphyseal fracture of the
distal 1/3 of the left tibia
AO 42 B2
> Diaphyseal fracture of tibia

with third fragment and
multifragmentary fibula
«Type of fracture: tibia with 3rd
fragment, fibula-ankle complex.
*Bone quality: good
*Reduction: indirect tibia, direct |
fibula-ankle

« Stability: relative tibia, absolute
fibula-ankle

+_Reduction and alignment check.

I

Figure 5

Preoperative planning of distal tibial diaphyseal fracture. (A) X-ray and CT images with measurements. (B) Patient and

fracture characteristics, use of contralateral limb as a template to calculate implant length and diameter, and surgical strategy.
(C) Surgical tactic list and graphic representation of the planning of closed reduction and endomedullary nailing of suprapatellar
tibia (optional) and open reduction and internal fixation internal fixation with one-third tubular neutralisation plate and fibular
screws (controversial). (D) Postoperative radiological findings, showing how the fixation of the fibula differs from the planning as a
plate was used as a bridge to provide relative stability. CR: closed reduction; IM: intramedullary; KW: Kirschner wire; ORIF: open

reduction and internal fixation.

roles of each member, enabling the preparation of the
necessary instruments, reducing the dose of intraoperative
fluoroscopy and avoiding unnecessary delays, unforeseen
events, and confusion during the operation." It also improves
technical outcomes by enabling more precise application
of theoretical knowledge about the appropriate implant
type, optimal placement site and fixation method, among
others." Comparing the postoperative result with the pre-
operative planning leads to reflection and improvement of
the future planning process.?’

Planning methods that employ more sophisticated tech-
nology have been greatly developed in recent years.
Computer-assisted surgical planning methods have been
described for the virtual reproduction of fractures and sim-
ulation of fracture reduction and fixation®®'° and methods
using 3D printing technology, which converts a computer-
generated 3D image into a physical model®® that aids in
preoperative planning and allows implants to be modelled
and adapted to individual bone morphology. In general,
these methods have great potential, but are currently tech-
nically complex, less reproducible, have a long learning
curve, are time-consuming, costly, and difficult to access,
which has led to their use being less widespread for the time
being.?' Furthermore, the clinical benefits'"?%2* and cost-
effectiveness of these advanced planning systems?* have not
been fully demonstrated.

With technological advances, the manual and attentive
process of tracing bone fragments and fracture lines, and the
manual simulation of reduction and fixation with implants,
is being lost to a large extent.?’ To date, we are not aware
of any work using commercial presentation programmes that
are simple and widely used to facilitate digital planning fol-
lowing the traditional method such as the one we propose
and have been using successfully for the last few years.
The alternative planning method we describe has more sim-
ilarities to that proposed by Jamali et al.,”> and by Kim
et al.,? to correct deformity and not for fracture manage-
ment, which use a photo and image editing software, Adobe®
Photoshop® (Systems Inc, San Jose, CA, USA). However,
it requires computer knowledge of that software, unlike
the abovementioned presentation programmes, which are
widely used in our society to communicate ideas or projects
in various contexts, from the educational environment such
as schools or universities, the scientific environment, to the
business and service sector.

One of the great advantages of the abovementioned dig-
ital planning method compared to conventional techniques
is that it is faster, modifications can be made to it and errors
corrected without having to restart the process, and the
plans can be saved and reused, and libraries of implants
created for future cases. Compared to planning techniques
that use more advanced technology, the advantages of the
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Igl — CR and MIS fixation with
LISS LCP distal femur plate.

+ Supine position, 30° knee flexion + pad under
the ipsilateral buttock. Fluoroscope.

« Distal femur lateral MIS approach, centered on
epicondyle, without arthrotomy.

« Indirect reduction restoring alignment, length
and rotation.

« Submuscular placement of 9-hole (236mm)
LISS LCP DF 4.5/5.0 plate.

. mporary plate fixation with distal and proximal

+ >4-5 distal locking screws (5.0 mm).

« Percutaneous placement of 3-4_bicortical
proximal locking screws (5.0 mm) and 1
monocortical screw (5.0 mm).

|E| PREOPERATIVE DATA:
«72-year-old female.
*Accidental fall in the street.
«Left knee TKA in 2009.

Peri TKA fracture
Lewis and Rorabeck type Il
ucs v.3-B1

» Supracondylar femur fracture
with stable TKA

«Fracture type: simple

*Bone quality: poor

«Reduction: indirect
« Stability: relative

Figure 6

Preoperative planning of femoral fracture around a TKR. (A) X-ray images with measurements. (B) Patient characteristics,

analysis and segmentation of the fracture and surgical strategy. (C) List of surgical steps and graphic representation of the planning
of indirect reduction and internal fixation with LISS-LCP distal femoral plate and percutaneous locking screws. (D) Postoperative
radiological result after reduction and fixation with variable angle compression condylar plate and locking screws. CR: closed
reduction; DF: distal femur; KW: Kirschner wires; LCP: locking compression plate; LISS: less invasive stabilisation system; MIS:

minimal invasive surgery; TKA, Total Knee Arthroplasty.

method described are its simplicity, low cost, minimal learn-
ing curve, accessibility, and reproducibility. Drawing the
anatomy and fracture develops visuospatial and recognition
skills, as well as, motor skills in surgical performance.? In
addition, drawing the implants leads the surgeon to become
familiar with the implants and to precisely know the lengths
and design of each specific plate or nail, and to know the
inventory of implants available at their centre and the need
to order specific implants or sizes. Another strength of this
planning method is that it preserves the instructional char-
acter of traditional methods: in the teaching environment
it is a simple and indispensable tool for the specialist in
training. In this sense, it helps the surgeon to prepare cases
thoroughly, encourages the search for for the most appro-
priate solutions, facilitates the mental rehearsal of the
surgical plan, allows solid and lasting learning of the surgical
technique, forces the specialist in training to make deci-
sions, stimulates educational discussions between residents
and more experienced specialists, and makes the surgical
approach more consistent. Therefore, we advocate digital
planning following the described method even for relatively
simpler fractures in which trainees can be involved, since
early introduction to the practice of planning with simple
cases will improve their ability to deal with the real case
and their experience in planning more complex fractures.
The limitations of this planning technique are those
derived from the quality of the diagnostic images and
the accuracy of the measurements made on the digital
medical image viewer from X-ray or CT scans. Therefore,

we recommend intraoperative verification of implant sizes
and lengths, which are decisive to ensure correct sizing.
Nevertheless, significant deviation from preoperative plan-
ning serves as a warning of a of potential surgical error.'
Another obvious limitation is the use of 2-dimensions, as
this is a basic method, in contrast to advanced methods,
which use 3-dimensions and are more in line with the
real anatomy. Despite the limitations, we demonstrate how
with universally available commercial presentation soft-
ware, preoperative planning can be performed easily and
efficiently for ORT procedures and are of great educational
value.

Conclusions

The basic method of digital preoperative fracture plan-
ning described employs a digital medical image viewer for
measurements of X-ray and CT images and the commonly
used and widely available presentation programmes for
reproducing fracture fragments and fracture lines, as well
as simulating the reduction and the graphical representa-
tion of implants. This method combines the advantages of
the traditional pencil and paper technique, being simple,
reproducible, low cost, accessible and relatively fast and
efficient, with those of advanced methods, by simulating
reduction and fixation with implants, correcting errors with-
out having to restart the process and saving and reusing the
plans for future cases. Moreover, since it involves detailed
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fracture analysis and is based on the basic principles of
osteosynthesis, it is of great interest from an educational
point of view and is a very suitable tool for ORT specialists
in training.

For all these reasons, we encourage trauma surgeons in
training to use this method of preoperative planning of the
fractures they face on a day-to-day basis to acquire greater
experience in its management and to optimise their results.

Level of evidence

Level of evidence v.
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